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Vorbemerkungen


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Vorbemerkungen
• Die vorliegende Dokumentation gilt dem Erstanwender der OrCAD Capture Software. 

Sie soll weder als Trainingshandbuch noch als komplette Bedienungsanleitung 
verstanden werden. 

• Sie brauchen lediglich das Capture_Demo.zip File in einen Ordner Ihrer Wahl zu 
entpacken. 

• Aufgrund der Kompaktheit dieser Dokumentation kann nicht auf alle vorhandenen 
Befehle und deren Feinheiten eingegangen werden. Hierzu sei auf die umfangreiche 
Dokumentation innerhalb der Installation verwiesen, die sowohl als HTML wie auch als 
PDF Dokumentation vorliegt.

• Anhand eines einfachen Schaltplans werden die wichtigsten Schritte innerhalb des 
Designablaufs dargestellt, die es dem Erstanwender dieses Systems erlauben, mit 
einem Minimalaufwand an Einarbeitungszeit die ersten eigenen Aufgaben zu bewältigen.

• Nach einigen Vorabinformationen zur Software beginnt die Anleitung mit der 
Schaltungsvorlage auf Seite 7. 

• Sämtliche Befehle und Funktionen, die in dieser Anleitung verwendet werden, sind mit 
der Demo-Version durchführbar.



FlowCAD Confidential │ 5

OrCAD PCB Design Flow

• Wie in der Grafik zu erkennen ist, setzt sich der OrCAD PCB Designer Flow im 
Wesentlichen aus zwei Teilen zusammen.

• Dies sind das Stromlaufplanpaket Capture und das Layout Programm OrCAD PCB Editor.

• Beide Programmpakete werden natürlich durch weitere Subprogramme ergänzt, die im 
jeweiligen Verbund ein optimales Werkzeug darstellen, das es dem Anwender 
ermöglicht, sämtliche Aufgaben mit maximaler Effizienz zu erledigen.

Capture

Symbol
Library

AutoRouter
SpecctraRouter

Netlist

Schaltungsentwickler OrCAD PCB Editor
Stromlaufplan Board Layout Fertigungsausgabe

Reports

Gerber &
Drill

Footprint
Library

View, Plot

Stücklisten

CIS-DB

Layout



FlowCAD Confidential │ 6

Capture Design Flow

Die Grafik zeigt den typischen Ablauf bei der Erstellung eines Stromlaufplans für den 
anschließenden Layout Entwurf. Die Punkte 1 bis 10 stellen die einzelnen Arbeitsschritte im 
Designablauf dar, auf die im Folgenden näher eingegangen werden soll. Der Hauptarbeit 
beginnt mit der Projekterstellung und endet mit der Netzlistengenerierung für das Layout. 
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Schaltungsvorlage
Die Schaltung, die in diesem Schnellstart umgesetzt werden soll, ist hier dargestellt:
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Nach dem Start von 
Capture öffnet sich das 
Capture Session Frame
Fenster. 

Start über:
Start > Alle Programme > 
Cadence Release 17.2 > 
OrCAD Products > 
Capture CIS

oder

Verknüpfung

Start von Capture
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Beim Start wird die interaktive Startseite geladen, mit der Sie vorhandenen Projekte öffnen 
bzw. neue erstellen können. Des Weiteren erhalten Sie zusätzliche Information wie 
Application Notes, Trainingsdaten, usw.

Start Page
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Neues Projekt aufsetzen


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Übung: Neues Projekt erstellen

Im oberen Feld unter Name tragen Sie den Namen Ihres 
Projekts ein, z. B. Power_Supply.

Als Projekt_Typ wählen Sie PC Board Wizard, da wir mit 
diesem Projekt später auch ein Layout erstellen wollen.

Im unteren Feld unter Location wählen Sie den Ordner, in 
dem das neue Projekt gespeichert werden soll. 

Empfehlenswert ist es für jedes Projekt einen eigenen Ordner 
anzulegen.

Da wir keine Simulation durchführen wollen, bleibt 
Enable project simulation deaktiviert.

File > New > Project… erstellt ein neues Projekt, in dem Design gespeichert wird.
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Library Zuweisungen
• Hier werden die in dem Projekt 

benötigten Libraries zugewiesen.

• Im linken Fenster befinden sich alle  
Libraries, die bei der Installation der 
Software installiert wurden. Es können 
jederzeit Libraries nachgetragen werden. 
Im rechten Fenster sind die dem Projekt 
zugeordneten Libraries gelistet.

• Die Zuweisung erfolgt durch Selektion 
der gewünschten Library und Add.

• Fügen Sie die im Bild rechts 
dargestellten Libraries hinzu.

• Klicken Sie auf Fertig stellen.

• Die verwendeten Libraries können 
jederzeit angepasst werden, wie im 
Absatz Bauteilplatzierung auf Seite 17 
beschrieben ist.
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Projekt Power_supply
Ein neues Projekt namens 
Power_supply mit einem Design 
gleichen Namens 
power_supply.dsn ist angelegt.

Gleichzeitig wurde die erste Seite 
Ihres Designs mit dem Namen 
PAGE1 geöffnet. 

Bitte beachten Sie die 
Ordnerstruktur im Projektmanager 
auf der linken Seite des Bildes.

Die Ordnerstruktur ist virtuell, d. h. 
sie existiert nur innerhalb des 
Projektmanagers. Die unter 
Schematic befindliche PAGE1 ist 
nur innerhalb des 
power_supply.dsn Files zu finden. 

Im Unterschied dazu sind die unten 
eingetragenen Libraries als 
physikalische Files unter den 
ebenfalls dargestellten Pfaden 
vorhanden.

Um den Projekt Manager zu fixieren, 
darf er nicht auf Maximum stehen. 
Klicken Sie mit rechter Maustaste auf 
das Register und anschließend „Docked 
to“→ left
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Setup – Grid Display
Unter Options > Preferences sollte im Grid
Display das Grid Spacing auf 1/1 stehen. 
Dies stellt sicher, dass die Kontaktpunkte der 
Bauteile auf dem Grid liegen und problemlos 
angeschlossen werden können.

Snap to Grid sollte beim normalen Arbeiten 
mit Capture aktiviert sein, um zu vermeiden, 
dass Bauteile außerhalb des Grids platziert 
werden:


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Setup – Rahmen
Das Erscheinungsbild des Rahmens lässt sich unter Options > Schematic Page Properties einstellen. In den Grid
References lässt sich die Unterteilung des Rahmens und dessen Breite festlegen (Capture passt die Rahmenbreite an die 
Grid Einstellungen an).

Tipp
Die Einstellungen lassen sich auch in ein Template 
speichern, das sich auf alle neuen Pages und 
Projekte auswirkt. 
Hierzu können die Einstellungen unter Options > 
Design Template gemacht werden. 

Näheres hierzu ist im Kapitel Einstellungen und 
Vorlagen ab Seite 49 zu finden.
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Bauteilplatzierung


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Bauteilplatzierung (I)
Um neue Bauteile zu platzieren, 
können Sie eine der drei 
Möglichkeiten nutzen:

• Place > Part... über 
das Pull-down-Menü

• P (Tastatur)

• Place Icon
am rechten Rand

Tipp
Damit die Schematic Icon-
Leiste sichtbar ist (rechter 
Rand), muss eine der in 
der Schematic vorhandenen 
Seiten aktiviert sein.
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Bauteilplatzierung (II)
Nach dem Platzierungskommando erhalten Sie das 
abgebildete Menü.

Unter Libraries können Sie eine oder auch mehrere 
Libraries anwählen, in welchen nach Ihrem Bauteil (Part) 
gesucht werden soll.

Unter Part wird die Bauteilbezeichnung eingegeben. Diese 
fungiert bereits als Filter, allerdings ohne Wildcards „*“.

In der Part List wird das Suchergebnis und die zugehörige 
Library ausgegeben.

Search for Part erlaubt ein Suchen auch mit Wildcards.

Add Library erlaubt das Hinzufügen von Libraries in 
den Suchpfad.

Unter Packaging wird angezeigt, ob ein Baustein aus 
mehreren Gattern bzw. Sektionen besteht (z. B. 
Widerstandsnetzwerk).

Mit einem Doppelklick in der Part List gelangen Sie 
zurück in das Schematic und können das Bauteil mit der 
LMB (Left Mouse Button) platzieren.
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Bauteilplatzierung (III)
Beim Platzieren werden Sie feststellen, dass der LM317 nicht 
in den bereits eingebundenen Bibliotheken vorhanden ist.

Add Library erlaubt das Hinzufügen von Bibliotheken in 
den Suchpfad.

Bitte binden Sie diese Bibliotheken mit ein:
~\Capture_Demo_17.2\Quickstart_solution\QUICKSTART.OLB

Wie Sie neue Bauteile, die in keiner vorhandenen Bibliotheken 
zu finden sind, definieren können, ist im Kapitel Bibliotheken
ab Seite 35 beschrieben.
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Text – Hinzufügen / Bearbeiten
Reine Text Notes können mit 

• Place > Text

• T (Tastatur)

oder dem

• Place Text Icon

dem Schematic hinzugefügt werden.

Schriftart und Größe lässt sich beim Platzieren des Textes 
mit Change anpassen.



FlowCAD Confidential │ 21

Verbindungen


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Verbindungen (I) – Auto Wire
Two Points 

Zwei selektierte Pins werden automatisch 
miteinander verbunden.

Multiple Points

Mehrere selektierte Pins werden automatisch 
miteinander verbunden.

Connect to Bus

Mehrere Selektierte Leitungen werden mit 
einem Bus verbunden. 
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Verbindungen (II) – Auto Wire
Wenn Sie beispielsweise Auto Connect Two Points aktivieren, müssen Sie im Schaltplan nur zwei Pins oder Leiterbahnen 
selektieren und die Leitung wird automatisch gezeichnet.
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Verbindungen (III) – Manuell
Das Verbinden kann auch 
manuell erfolgen:

• Place > Wire

• W (Tastatur)

oder dem 

• Place Wire Icon

Beim manuellen Platzieren 
muss die Leitung bei jedem 
Richtungswechsel durch links 
Klicken abgesetzt werden.

Ansonsten ist die 
Vorgehensweise identisch zum 
Auto Wire-Befehl.
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Verbindungen (IV) – Arbeitsweise
Das Verdrahten erfolgt durch einen 
Klick auf ein offenes Ende, 
gekennzeichnet durch ein Quadrat 
am Pin. Dieser Marker erlischt 
nach dem Anschluss einer 
Verbindung.

Der rote Punkt kennzeichnet ein 
Pin, welcher nun zum Anschließen 
zur Verfügung steht. Ein weiterer
Klick auf diesen Punkt 
vervollständigt die Verbindung, und 
der rote Punkt wie auch das 
Quadrat verschwinden. 
Ein Doppelklick beendet die 
aktuelle Verbindung.

Kreuzungen stellen nur dann eine 
Verbindung dar, wenn manuell ein 
Dot bzw. Junction gesetzt wird 
oder eine T-Verbindung als 
Zwischenschritt genutzt wird.

Durch einfaches Selektieren einer 
Verbindung und Drücken der 
Entf-Taste kann eine bestehende 
Verbindung wieder gelöscht 
werden. 

Tipp
Die Ctrl-Taste erlaubt die gleichzeitige Selektierung mehrerer Elemente.
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Verbindungen (V) – Netznamen
Netznamen vergeben

Sollen auf einer Seite Bauteile 
miteinander verbunden werden, 
so erfolgt dies mittels des 
Place > Wire Kommandos 
durch das Ziehen von 
Drahtverbindungen.

Eine weitere Möglichkeit 
besteht in der Verwendung 
von Net Aliases.

Place > Net Alias...

Place Net Alias Icon

Hierbei wird den Netzen ein 
Netzname zugewiesen und 
darüber die Verbindung zweier 
Bauteile realisiert. Als Beispiel 
dient hier das Netz mit dem 
Namen plus.

Tipp
Sollen Netze mittels Netznamen über mehrere Seiten oder auch über das Design hinweg verbunden werden, so sind 
Offpage Connectoren bzw. Port Connectoren zu verwenden. Näheres hierzu ist in der Dokumentation ersichtlich.
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Weitere Schritte


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Properties editieren (I)
Etwa so dürfte der fertige Stromlaufplan nach Platzierung und Verdrahtung aussehen:

Unter Umständen 
stimmt die Beschriftung 
der Bauteile (RefDes, 
Value) nicht mit der 
Schaltungsvorlage auf 
Seite 8 überein.

Um dies zu korrigieren, 
können die Values und 
REFDES der Bauteile 
editiert werden, was 
auch im Sinne einer 
späteren Stückliste ist. 

RefDes

Value
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Properties editieren (II)
REFDES und Value editieren

Das Property Fenster kann durch 

Selektieren (LMB) und RMB > Edit Properties …

oder durch einen

Doppelklick

der gewünschten Property geöffnet werden.

Über Display Format sind verschiedene Einstellungen bezüglich der 
Sichtbarkeit im Stromlaufplan möglich.

Tipp
Es können gleichzeitig mehrere oder alle Symbole einer Seite 
oder gar des gesamten Designs im Property Editor aufgerufen 
werden.

• Ctrl + LMB-Klick oder Ctrl + A und anschließend RMB > 
Properties...

• Im Project Manager, Page oder Design (.dsn) selektieren, 
Edit Object Properties aus dem Pull-down-Menü.
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Packagen – Annotation
Packagen und Annotierung von Bauteilen

Auf der vorherigen Seite haben Sie die Referenzen der 
Bauteile manuell vergeben. Während des Editierens 
kontrolliert Capture nicht, ob Sie doppelte Bezeichner (2 x U1, 
oder 3 x R5) vergeben haben. Die Kontrolle erfolgt erst beim 
Generieren der Netzlisten.

Über Tools > Annotate… haben Sie aber die Möglichkeit, 
diese Arbeit automatisch zu erledigen, und das ohne doppelte 
Bezeichner. Hierbei sind vielfache Optionen wählbar 
(selektieren Sie im Projektverzeichnis zuerst die .DSN Datei, 
sonst ist der Befehl Annotate nicht verfügbar).
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Fertiger Stromlaufplan
Nachdem die Schaltung angepasst und evtl. Elemente und Beschriftung ausgerichtet wurden, sollte der fertige 
Stromlaufplan in etwa das hier gezeigte Aussehen haben.

Anmerkung
An dieser Stelle sei angemerkt, dass in 
Abhängigkeit der verwendeten  Libraries 
die Zuweisung der Footprints (DIP14, 
SO14, SMD1206 usw.) unter 
Umständen in dieser Schaltung noch 
nicht erfolgt ist.
Mit diesem Thema werden wir uns zu 
einem späteren Zeitpunkt (beim 
Importieren der Netzliste in das 
Layoutprogramm) befassen.
Hier nur soviel:
Die Footprint Zuweisung muss bereits 
im Schaltplan erfolgen. Ein fehlender 
Footprint Eintrag führt zu einer 
Fehlermeldung bei der Netzlisten-
Generierung.
Ist der Name noch nicht klar, kann 
irgend ein Text eingegeben werden. 
Footprints können in der Library 
vorgegeben sein oder über den Property 
Editor nachgepflegt werden.
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Design Rule Check

Mit dem DRC lassen sich z. B. 1-pinnige Netze und 
Netze ohne Input oder Output erfassen, sofern die 
Libraries richtig definiert wurden (selektieren Sie im 
Projektverzeichnis zuerst die .dsn-Datei, sonst ist der 
Befehl Design Rule Check nicht verfügbar).
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Materialliste (BOM)
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Netzlisten generieren

Mit dem Netzlisten Tool kann die für den 
OrCAD PCB Editor benötigte Netzliste erzeugt 
werden (selektieren Sie im Projektverzeichnis 
zuerst die .DSN Datei, sonst ist der Befehl 
Create Netlist... nicht verfügbar).
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Bibliotheken


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Fehlende Bauteile
In diesem Kapitel wird beschrieben, wie neue Bauteile erzeugt werden, die nicht in den von 
OrCAD bereitgestellten Bibliotheken vorhanden sind.

Die Vorgehensweise wird am Beispiel des LM317 dargestellt, der nicht in den ursprünglich 
angebundenen Libraries
• Counter.olb
• Discrete.olb
• OPAMP.olb
aufzufinden war.

Das fertige Bauteil ist in der 
• Quickstart.olb
vorhanden.
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Neue Bibliothek (I)
Sie können neue Elemente in 
einer neuen Library anlegen 

oder 

eine bestehende Library öffnen, 
und hier neue Bauteile 
hinzufügen.

Beide Aktionen erfolgen über

• File > New > Library

oder

• File > Open > Library
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Neue Bibliothek (II)
Im Projekt Manager kann über 
RMB > Save As... die neue 
Library im gewünschten Pfad 
abgespeichert werden.

Diese Library kann anschließend 
in Ihr bestehendes Projekt 
eingebunden werden.  
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Bauteil anlegen (I)
Mit Design > New Part...

oder

RMB > New Part

starten Sie die Erstellung eines neuen 
Bauteils in der aktuellen Library.
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Bauteile anlegen (II)

Neuer Bauteilname:

Part Reference Prefix:

PCB Footprint:

Part Aliases:
Gleiches Symbol, gleiche Funktion 
aber verschiedene Gehäuse

Parts per package:
z. B. 4 Gatter im 74LS00

Homogen:
Mehrere gleiche Schaltungen,
z. B. 74LS00

Heterogen:
z. B. Relais mit Spule und Schalter

Partnummerierung:
U?A, U?B ... oder U?1, U?2 ...

Klick OK.

Tragen Sie die dargestellten Werte in das Menü ein.
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Befehle in Capture
In der Capture Oberfläche sind nun die zum Bearbeiten der Bauteils benötigten Befehle verfügbar, sowohl als 
Schaltflächen am rechten Rand, wie auch unter Place. 

Die Funktion der Buttons 
wird durch Mouse Over
Hinweise angezeigt.

Auf den nächsten Seiten 
werden die wichtigsten 
Funktionen kurz erläutert.
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Pins hinzufügen (I)
Platzieren der Pins durch:

• Place > Pin...

oder

• Place Pin Icon
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Pins hinzufügen (II)
Das Place Pin Fenster erscheint, in dem die Pin Eigenschaften festgelegt werden.

Pin Type Property

Wenn OK angeklickt wird, hängt der Pin an der Maus in 
kann platziert werden.

Tipp
Bei Verwendung von Power als Pin Typ kann der Pin 
sichtbar oder unsichtbar geschaltet werden.
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Pins hinzufügen (III)
Die einzelnen Pins werden platziert

Weitere Pins können über das 
vorherige Menü oder über 
Copy&Paste (Ctrl-C, Ctrl-V)
platziert werden.

Die Platzierung der Pins erfolgt 
immer entlang der gestrichelten 
Linie.

Bei Verwendung von Copy&Paste 
müssen z. B. Pin Nummer und Pin 
Name nach dem Kopieren 
entsprechend dem Datenblatt 
korrigiert werden.

Dies kann einzeln oder für alle 
gemeinsam geschehen.

Aufruf: Doppelklick oder RMB

Menüs nächste Seite
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Pins hinzufügen (IV)
Pin Eigenschaften definieren

Über User Properties… können den einzelnen Pins 
zusätzlich Informationen mitgegeben werden, wobei 
diesen wiederum bestimmte Attribute zugeordnet 
werden können (z. B. sichtbar / unsichtbar).
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Symbol zeichnen

Abschließend wird dem Symbol die reguläre Outline 
zugeordnet.

Dies geschieht durch:

• Place > Rectangle

• Place > Polyline

usw.

Alternativ können die betreffenden Icons auf der rechten 
Seite des Part Editor Fensters verwendet werden.

Fertigstellen des Symbols:

Tipp
Die gestrichelte Linie ist nur ein Hilfsrahmen, der in dem 
Schematic nicht sichtbar ist. Der Symbolrahmen stellt 
den realen Platzbedarf der Grafik innerhalb des 
Schematic dar.

Das Rechteck kann selektiert und über die Ecken 
gedehnt oder gestaucht werden. Der gestrichelte 
Rahmen ist immer mindestens so groß wie der reale 
Symbolkörper, wird aber nur beim Vergrößern
automatisch mitgeführt.
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Fertiges Bauteil
Fertiges Symbol LM317

Speichern nicht vergessen!

Tipp
Weitere Beschriftungen oder Symbolik 
innerhalb des Bauteils können über 
Place > Text und Place > Line
hinzugefügt werden.
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Verwaltung in Bibliotheken
Sie können library1.olb als Power_supply.olb
speichern. In der Power_supply.olb ist jetzt der 
Spannungsregler LM317 gespeichert.

Sollten weitere Elemente benötigt werden, können 
diese ebenfalls innerhalb dieser Library erstellt werden.

Die Library kann wie auf Seite 19 beschrieben in 
Design Projekte eingebunden werden.

In der Quickstart.olb sind alle Bauteile vorhanden, die 
in diesem Schnellstart verwendet werden.
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Einstellungen und Vorlagen


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Design Template – Title Block
Unter Options > Design Template können 
Voreinstellungen für neue Projekte und 
neue Seite im bestehenden Projekt 
gemacht werden.

Im Reiter Title Block können das 
Beschriftungsfeld und die darin 
verwendeten Textbausteine gesetzt werden.
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Design Template – Page Size
Unter Page Size wird die Zeichnungsgröße festgelegt.

Achtung
Die Einstellung unter Pin-to-Pin Spacing
müssen mit dem in der Library verwendeten 
Pin-to-Pin Spacing übereinstimmen, 
um spätere Probleme beim Setzen und 
Verbinden der Bauteile zu vermeiden.
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Design Template – Grid Reference

Unter Grid Reference wird die Breite 
des Zeichnungsrahmens und dessen 
Unterteilung festgelegt.

Breite
Width

Unterteilungen
Count
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Anhang


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Systemvoraussetzung (Vollversion 17.2)
Betriebssysteme Windows 2008 Server (R2 und 2012 R2)

Windows 7 Professional, Enterprise, Home Premium 
Windows 8 und 8.1 
Windows 10 

Hardware Intel core i3 oder besser (kompatibel AMD) 
1.2 GHz Minimum; 2.4 GHz oder mehr ist zu empfehlen 
Maus mit drei Tasten (+ Scrollrad)
Netzwerkkarte (falls MAC / Ethernet Lizenzierung)

Minimum 4 GB RAM
50 GB Festplatte
Virtueller Speicher sollte mindestens doppelt groß wie RAM sein
1024 x 768 Auflösung mit 64,000 Farben

Empfohlen 8 GB RAM
100 GB Festplatte
Virtueller Speicher sollte mindestens doppelt groß wie RAM sein
Eigenständige Grafikkarte mit 1 GB
1280 x 1024 Farbe Qualität 32 Bit Grafik
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Eigenschaften der Vollversion
Allgemein
• Raster in Millimeter und Zoll einstellbar
• Einfaches Erstellen und Bearbeiten von Libraries
• Forward-Backward Annotation
• Cross-Probing zwischen Design Entry (Capture) und Layout (PCB Editor)

Schaltplaneditor Capture
• Zeichenfläche bis 11.430 x 11.430 mm
• Mehrere Designs innerhalb eines Projektes möglich
• Hierarchische Strukturen mit automatischer Synchronisierung
• Automatische Referenzierung der Bauteile
• Electrical Design Rules Check (einstellbar)
• Einstellbarer automatischer Zeichnungsrahmen und Schriftkopf
• Ausgabe verschiedener Netzlistenformate
• TCL Interface
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Einschränkungen der Demo-Version
• Die kostenlose Demo-Version ist ein voll funktionsfähiges Design-Paket inklusive PSpice, das 

lediglich in der Anzahl der Bauteile, Bauteilepins, Netzknoten und Einbindung zusätzlicher 
Simulationsmodelle beschränkt ist.

• Sie können kleine Schaltungen im Stromlaufplan entwerfen, simulieren und davon ein Layout 
anfertigen.

• Die Daten können gespeichert werden.
• Auch die Ausgabe von Fertigungsdaten ist möglich.
• Größere Schaltungen und Layouts können betrachtet, aber nicht abgespeichert werden.  

In der aktuellen Version 17.2 sind im Design Entry OrCAD Capture diese Limits zu beachten:
• Maximal 60 Bauteile und 75 Netze einschließlich Hierarchien
• Maximal 100 Pins pro Bauteil
• Maximal 1000 Parts in der CIS- Library
• FPGA Flow ist nicht verfügbar
• Electrical CSets werden nicht überprüft  
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Installation und Einstellungen
• In der Vollversion 17.2 ist die Demo-Version enthalten. 
• Wenn Sie die 17.2 Vollversion installiert haben, wird beim Starten automatisch auf eine Demo-Version 

umgeschaltet, falls Sie keinen Lizenzserver installiert haben.

• Beim Einlegen der DVD startet das Setup-Programm selbstständig, wenn Autorun aktiviert ist.
• Falls die Autorun-Funktion Ihres Rechners deaktiviert ist, öffnen Sie mit dem Windows Explorer den 

Ordner der DVD und starten Sie setup.exe.
• Starten Sie die Produkt-Installation. Folgen Sie den Anweisungen des Installationsprogramms. 

Installieren Sie keinen Lizenzmanager!
• Hinweis: Dies offizielle Installationsanleitung (pcbInstall.pdf) finden Sie unter < CD/DVD-Laufwerk > :\

Disk1\documents. Eine deutsche Installationsanleitung finden Sie auch auf dieser DVD.

• OrCAD erlaubt dem Benutzer ein Vielzahl von persönlichen Einstellungen, von der 
Produktkonfiguration über Designtemplates bis hin zur Farbwahl der verwendeten Designelemente. 
Auf diese Möglichkeiten wurde in diesem Schnellstart nicht eingegangen, da sie über den Umfang 
dieser Dokumentation hinausgehen. Es sei nur erwähnt, dass viele dieser Einstellungen in 
entsprechenden INI-Dateien gespeichert werden.
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Bedienkonzept
• OrCAD Capture ist grundsätzlich menügesteuert.
• Die verwendeten Menüs sind kontextsensitiv. Dies bedeutet, dass sich in Abhängigkeit der 

selektierten Elemente, Arbeitsflächen oder Befehle, die resultierenden Pop-up-Fenster bzw. das Pull-
down-Menü verändert.

• Sämtliche Eingaben bzw. Befehle erfolgen über eine der folgenden Möglichkeiten:
• Pull-down-Menüs
• Icons
• Kurztasten
• Pop-up-Fenster

• Es gibt keine klassische Kommandozeile. Allerdings besteht die Möglichkeit, TCL Skripte über das 
Command Fenster auszuführen.
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Dateien in OrCAD (Capture)
Die wichtigsten von OrCAD Capture verwendeten Dateien:
.OPJ Projekt 
.DSN Design
.DBK Backup
.OLB Symbol Library
.UPD Property Update Datei
.DRC Design Rules Check
.BOM Stückliste (Bill of Materials)
.EXP Property Export Datei
.MNL Layout Netzliste
.SWP Layout Backannotation
.VHD / .VHO VHDL Source 
.EDF / .EDN EDIF Netzliste oder Backannotation
.XRF Cross – Referenz
.NET Sonstige Netzliste

Anmerkung
• Zur Weitergabe und externen Bearbeitung von Designs ist nur das Design-File *.dsn erforderlich, da 

alle Designdaten hier enthalten sind. 
• Das Projekt-File *.opj ist sinnvoll, aber nicht zwingend nötig. Es enthält gewisse Voreinstellungen zum 

Projekt, wie verwendete Libraries, Ausgabedateien, Ordnereinstellungen usw. 
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Für weitere Fragen und Informationen stehen wir gerne zur Verfügung.
Please don‘t hesitate to contact us.

FlowCAD Deutschland
Mozartstr. 2
85622 Feldkirchen bei München
T +49 89 4563-7770
F +49 89 4563-7790
info@FlowCAD.de

FlowCAD Schweiz
Hintermättlistr. 1
5506 Mägenwil
T +41 56 485 91 91
F +41 56 485 91 95
info@FlowCAD.ch

FlowCAD Polen 
ulica Sasiedzka 2A
80-298 Gdansk
T +48 58 342 75 94
F +48 58 342 70 60
info@FlowCAD.pl

Kontakt zu FlowCAD / Contact us
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Don’t forget to subscribe, share and like! 

Follow us
www.facebook.com/FlowCAD
Join our Facebook page where we focus on giving a glimpse 
into ongoing innovations. You will find selected news, events, 
success stories and insights.

www.twitter.com/FlowCAD
On FlowCAD’s Twitter we provide press releases, news articles, 
films and images as well as reports from events.

www.youtube.com/FlowCAD
On our YouTube channel you will find 100+ video tutorials 
to learn more about electronic circuits. With the PSpice Lite 
version from our website everyone can easily simulate.
In our playlists we also offer product news and webinars.
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